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“Live in fragments no longer, only connect.”
—Edgar Morgan Forster

Welcome to Visual C#® 2012 and the world of Microsoft® Windows® and Internet and
web programming with Microsoft’s NET platform. Please read the book’s back cover and
inside back cover—these concisely capture the book’s essence. In this Preface we provide
more details.

We focus on software engineering best practices. At the heart of the book is the Deitel
signature “live-code approach”™—concepts are presented in the context of complete
working programs, rather than in code snippets. Each complete code example is accompa-
nied by live sample executions. All the source code is available at

www.deitel.com/books/cs2012fp/

If you have questions as you read the book, we’re easy to reach at deitel@deitel. com—
we'll respond promptly. For book updates, visit waw . dei tel. com/books/cs2012fp, join our
social media communities on Facebook (ww.deitel.com/DeitelFan), Twitter (@deitel),
Google+ (gplus.to/deitel) and LinkedIn (bit.1y/DeitelLinkedIn), and subscribe to the
Deitel® Buzz Online newsletter (www.deitel.com/newsletter/subscribe.html).

Visual C#® 2012, the Visual Studio® 2012 IDE, .NET 4.5,
Windows® 7 and Windows® 8

The new Visual C# 2012 and its associated technologies motivated us to write C# 2012
for Programmers, 5/e. These are some of the key features of this new edition:

*  Use with Windows 7, Windows 8 or both. The book is designed so that you can
continue to use Windows 7 now and begin to evolve to Windows 8, if you like,
or you can move right to Windows 8. All of the code examples in Chapters 1-22
and 26-33 were tested on both Windows 7 and Windows 8. The code examples
for the Windows-8-specific chapters—Chapter 23 (Windows 8 Ul and XAML),
Chapter 24 (Windows 8 Graphics and Multimedia) and Chapter 25 (Building a
Windows Phone 8 App)—were tested only on Windows 8, because Visual Studio
Express 2012 for Windows 8 and Visual Studio Express 2012 for Windows
Phone run only on Windows 8.

*  C# and Visual C#. The C# language has been standardized internationally by
ECMA and ISO (the standards document is available free of charge at bit.1y/
ECMA334). This enables other implementations of the language besides Micro-
soft’s Visual C#, such as Mono (www.mono-project.com), which runs on Linux
systems, iOS (for Apple’s iPhone, iPad and iPod Touch), Google’s Android and
Windows.
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Modular multi-GUI treatment with Windows Forms, Windows 8 UI and WPF.
The book features three different GUI treatments, starting with Windows Forms
GUI, later chapters contain treatments of the new Windows 8 UI (user interface)
and WPF GUI Windows 8 Ul apps are called Windows Store apps. In

Chapter 23, you’ll learn how to create and test Windows Store apps.

Modular treatment of graphics and multimedia with Windows 8 and WPF. The
book features chapters on both the new Windows 8 Graphics and Multimedia
(Chapter 24) and WPF Graphics and Multimedia (Chapter 31).

Database with LINQ to Entities. In the previous edition of this book, we dis-
cussed LINQ (Language Integrated Query) to SQL (Microsoft’s SQL Server da-
tabase system). Microsoft stopped further development on LINQ to SQL in
2008 in favor of the newer and more robust LINQ to Entities and the
ADO.NET Entity Framework, which we've switched to in this edition.

SQL Server database. We use Microsoft’s free SQL Server Express 2012 (which
installs with the free Visual Studio Express 2012 for Windows Desktop) to pres-
ent the fundamentals of database programming. Chapters 20-21 and 27 use da-
tabase and LINQ capabilities to build an address-book desktop app, a web-based
guestbook app, a bookstore app and an airline reservation system app.

ASP.NET 4.5. Microsoft’s NET server-side technology, ASP.NET, enables you
to create robust, scalable web-based apps. In Chapter 21, you'll build several
apps, including a web-based guestbook that uses ASP.NET and the ADO.NET
Entity Framework to store data in a database and display data in a web page. The
chapter also discusses the IIS Express web server for testing your web apps on
your local computer.

Building a Windows Phone 8 App. Windows Phone 8 is Microsoft’s latest smart-
phone operating system. It features multi-touch support for touchpads and
touchscreen devices, enhanced security features and more. In Chapter 25, you'll
build a complete working Windows Phone 8 app and test it on the Windows
Phone emulator; we discuss how to upload apps to the Windows Phone Store.

Building a Windows Azure™ Cloud Computing App. Windows Azure is a cloud
computing platform that allows you to develop, manage and distribute your apps
in the cloud. Chapter 29 shows you how to build a Windows Azure app that can
store data in the cloud. You'll test your app on the Windows Azure Storage Emu-
lator.

Asynchronous programming with async and await. Asynchronous programming
is simplified in C# 2012 with the new async and await capabilities. We intro-
duce asynchronous programming with async and await in Chapter 26. To take
advantage of multicore architecture you need to write applications that can pro-
cess tasks asynchronously. Asynchronous programming is a technique for writing
apps containing tasks that can execute asynchronously, which can improve app
performance and GUI responsiveness in apps with long-running or compute-in-
tensive tasks.
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Object-Oriented Programming

Other

Early-objects approach. The basic concepts and terminology of object technology
are introduced in Chapter 1. In Chapter 2, Dive Into® Visual Studio 2012 Ex-
press for Windows Desktop, you'll visually manipulate objects, such as labels and
images. In Chapter 3, Introduction to C# Apps, you'll write C# program code that
manipulates existing objects. You'll develop your first customized classes and ob-
jects in Chapter 4.

A clear, example-driven presentation of classes, objects, inheritance, polymor-
phism and interfaces.

Case study: Using the UML to develop an object-oriented design and C# implemen-
tation of an Automated Teller Machine (ATM). The UML™ (Unified Modeling
Language™) is the industry-standard graphical language for modeling object-ori-
ented systems. We introduce the UML in the early chapters. Chapters 32 and 33
include a case study on object-oriented design using the UML. We design and im-
plement the software for a simple automated teller machine. We analyze a typical
requirements document that specifies the system to be built. We determine the classes
needed to implement that system, the atributes the classes need to have, the behav-
iors the classes need to exhibit and we specify how the classes must interact with one
another to meet the system requirements. From the design we produce a complete
working C# implementation. Readers often report a “light bulb moment”—the
case study helps them “tie it all together” and understand object orientation more
deeply.

Multiple programming paradigms. We discuss structured programming, object-ori-
ented programming, generic programming and some functional programming.

Features
We use LINQ to query files, databases, XML and collections. The introductory
LINQ to Objects chapter (Chapter 9) will get you started using LINQ technol-

ogy early. Later in the book, we take a deeper look, using LINQ to Entities
(Chapters 2021 and 27) and LINQ to XML (Chapters 22 and 26).

Local type inference. When you initialize a local variable in its declaration, you
can omit the variable’s type—the compiler infers it from the initializer value.

Object initializers. For new objects, you can use object initializer syntax (similar
to array initializer syntax) to assign values to the new object’s public properties
and pub1i c instance variables.

We emphasize the IDE’s IntelliSense feature that helps you write code faster and
with fewer errors.

Files and strings.
Generics and collections.

Integrated exception handling. We introduce exception handling early
(Chapter 8, Arrays) to watch for attempts to access array elements outside the ar-
ray’s bounds. Chapter 10, Classes and Objects: A Deeper Look, shows how to in-
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dicate an exception when a member function receives an invalid argument. We
cover the complete details of exception handling in Chapter 13, Exception Han-
dling: A Deeper Look.

C# XML capabilities. Extensible Markup Language (XML) is pervasive in the
software-development industry and throughout the .NET platform. In
Chapter 22, we introduce XML syntax and programmatically manipulate the el-
ements of an XML document using LINQ to XML. XAML is an XML vocabu-
lary that’s used to describe graphical user interfaces, graphics and multimedia. We
discuss XAML in Chapters 23-24 and 30-31.

Web app development with ASP.NET 4.5 and ASP.NET Ajax. Chapter 27 ex-
tends Chapter 21’s ASP.NET discussion with a case study on building a pass-
word-protected, web-based bookstore app. Also, we introduce in Chapter 27
ASP.NET Ajax controls and use them to add Ajax functionality to web apps to
give them a look and feel similar to that of desktop apps.

Windows Communication Foundation (WCF) web services. Web services enable
you to package app functionality in a manner that turns the web into a library of
reusable services. Chapter 28 includes a case study on building a math question
generator web service that’s called by a math tutor app.

WPF (Windows Presentation Foundation) GUI, graphics and multimedia.
Chapters 30-31 provide an introduction to Windows Presentation Foundation
(WPF)—a XAML-based Microsoft framework that preceded Windows 8 UI and
integrates GUI, graphics and multimedia capabilities. WPF was designed as a re-
placement for Windows Forms GUI technologies. We implement a painting
app, a text editor, a color chooser, a book-cover viewer, a television video player,
various animations, and speech synthesis and recognition apps.

Training Approach

C# 2012 for Programmers, 5/e stresses program clarity and concentrates on building well-
engineered software.

Live-Code Approach. The book includes hundreds of “live-code” examples—each new
concept is presented in the context of a complete working C# app that is immediately fol-
lowed by one or more actual executions showing the program’s inputs and outputs. We
include a broad range of example programs selected from computer science, business, sim-
ulation, game playing, graphics, multimedia and many other areas.

Syntax Shading. For readability, we syntax shade the code, similar to the way most inte-
grated-development environments and code editors syntax color the code. Our syntax-
shading conventions are:

comments appear like this

keywords appear 1ike this in bold black
constants and literal values appear like this
all other code appears in non-bold black

Code Highlighting. We place gray rectangles around each program’s key code segments.
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Using Fonts for Emphasis. We place the key terms and the index’s page reference for each
defining occurrence in bold italic text for easier reference. We emphasize on-screen com-
ponents in the bold Helvetica font (e.g., the File menu) and emphasize C# program text in
the Lucida font (e.g., int x = 5).

Web Access. All of the source-code examples can be downloaded from:
www.deitel.com/books/cs2012fp
Objectives. Each chaprer begins with a list of chapter objectives.

Programming Tips. The book includes hundreds of programming tips and practices that
represent the best we've gleaned from a combined eight decades of programming and
teaching experience.

Good Programming Practice
The Good Programming Practices call attention to techniques that will help you pro-
duce programs that are clearer, more understandable and more maintainable.

Common Programming Error
Pointing out these Common Programming Errors reduces the likelihood that you'll
make them.

Error-Prevention Tip

These tips contain suggestions for exposing and removing bugs from your programs; many
of the tips describe aspects of C# that prevent bugs from getting into programs in the first
place.

Performance Tip
:@ These tips highlight opportunities for making your programs run faster or minimizing the
amount of memory that they occupy.

Portability Tip
@ The Portability Tips help you write code that will run on a variety of platforms.

Software Engineering Observation
E The Software Engineering Observations highlight architectural and design issues that
affect the construction of software systems, especially large-scale systems.
Look-and-Feel Observation
| These observations help you design atiractive, user-friendly graphical user interfaces that
conform to industry norms.

New
= ] Open.
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\ \ G
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Obtaining the Software Used in This Book

We wrote the code examples in C# 2012 for Programmers, 5/e using Microsoft’s free Visual
Studio Express 2012 products, including:
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*  Visual Studio Express 2012 for Windows Desktop (Chapters 1-20, 22, 26, 29
and 30-33), which includes Visual C# and other Microsoft development tools.
This runs on Windows 7 and 8.

*  Visual Studio Express 2012 for Web (Chapters 21 and 27-28
*  Visual Studio Express 2012 for Windows 8 (Chapters 23-24)
*  Visual Studio Express 2012 for Windows Phone (Chapter 25)

Each of these is available for download at

www.microsoft.com/visualstudio/eng/products/
visual-studio-express-products

C# 2012 Fundamentals: Parts I, II, Ill and IV, Second Edition LiveLes-
sons Video Training

Our C# 2012 Fundamentals: Parts I, I1, Il and IV LiveLessons video training shows you
what you need to know to start building robust, powerful software with C# 2012. It in-
cludes approximately 40 hours of expert training synchronized with C# 2012 for Program-
mers, 5/e. For additional information about Deitel LiveLessons video products available on
Safari Books Online and other electronic channels, visit

www.deitel.com/1ivelessons

or contact us at deitel@deitel.com.
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This section contains information you should review before using this book and instruc-
tions to ensure that your computer is set up properly for use with this book.

Font and Naming Conventions

We use fonts to distinguish between features, such as menu names, menu items, and other
elements that appear in the program-development environment. Our convention is to em-
phasize IDE features in a sans-serif bold Helvetica font (for example, Properties window)
and to emphasize program text in a sans-serif Lucida font (for example, bool x = true).

Software
This book uses the following software:
*  Microsoft Visual Studio Express 2012 for Windows Desktop
*  Microsoft Visual Studio Express 2012 for Web (Chapters 21 and 27-28)
*  Microsoft Visual Studio Express 2012 for Windows 8 (Chapters 23-24)
*  Microsoft Visual Studio Express 2012 for Windows Phone (Chapter 25)
Each is available free for download at www.microsoft.com/express. The Express Editions

are fully functional, and there’s no time limit for using the software.

Hardware and Software Requirements for the Visual Studio 2012 Express Editions
To install and run the Visual Studio 2012 Express Editions, ensure that your system meets
the minimum requirements specified at:

www.microsoft.com/visualstudio/eng/products/compatibility
Microsoft Visual Studio Express 2012 for Windows 8 works only on Windows 8.
Viewing File Extensions
Several screenshots in C# 2012 for Programmers, 5/e display file names with file-name ex-

tensions (e.g., .txt, .cs or .png). Your system’s settings may need to be adjusted to dis-
play file-name extensions. Follow these steps to configure your Windows 7 computer:

1. In the Start menu, select All Programs, then Accessories, then Windows Explorer.

2. Press Al to display the menu bar, then select Folder Options... from Windows Ex-
plorer’s Tools menu.

3. In the dialog that appears, select the View tab.

4. In the Advanced settings: pane, uncheck the box to the left of the text Hide ex-
tensions for known file types. [/Note: If this item is already unchecked, no action
needs to be raken.]

5. Click OK to apply the setting and close the dialog.
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Follow these steps to configure your Windows 8 computer:
1. On the Start screen, click the Desktop tile to switch to the desktop.
2. On the task bar, click the File Explorer icon to open the File Explorer.

3. Click the View tab, then ensure that the File name extensions checkbox is
checked.

Obtaining the Code Examples
The examples for C# 2012 for Programmers, 5/e are available for download at

www . dei tel.com/books/cs2012fp/

If you're not already registered at our website, go to www.deitel. comand click the Register
link below our logo in the upper-left corner of the page. Fill in your information. There’s
no charge to register, and we do not share your information with anyone. We send you
only account-management e-mails unless you register separately for our free e-mail news-
letter at www.deitel.com/newsletter/subscribe.html. You must enter a valid e-mail
addpress. After registering, you'll receive a confirmation e-mail with your verification code.
Click the link in the confirmation email to go to www.deitel.com and sign in.

Next, go to www.deitel.com/books/cs2012fp/. Click the Examples link to down-
load the ZIP archive file to your computer. Write down the location where you save the
file—most browsers will save the file into your Downloads folder.

Throughout the book, steps that require you to access our example code on your com-
puter assume that you've extracted the examples from the ZIP file and placed them at
C:\Examples. You can extract them anywhere you like, but if you choose a different loca-
tion, you'll need to update our steps accordingly. You can extract the ZIP archive file’s
contents using tools such as WinZip (www.winzip.com), 7-zip (www.7-zip.org) or the
built-in capabilities of Windows Explorer on Window 7 or File Explorer on Windows 8.

Visual Studio Theme

Visual Studio 2012 has a Dark theme (the default) and a Light theme. The screen captures
shown in this book use the Light theme, which is more readable in print. If you'd like to
switch to the Light theme, in the TOOLS menu, select Options... to display the Options di-
alog. In the left column, select Environment, then select Light under Color theme. Keep the
Options dialog open for the next step.

Displaying Line Numbers and Configuring Tabs

Next, you'll change the settings so that your code matches that of this book. To have the
IDE display line numbers, expand the Text Editor node in the left pane then select All Lan-
guages. On the right, check the Line numbers checkbox. Next, expand the C# node in the
left pane and select Tabs. Make sure that the option Insert spaces is selected. Enter 3 for
both the Tab size and Indent size fields. Any new code you add will now use three spaces
for each level of indentation. Click OK to save your settings.

Miscellaneous Notes

*  Some people like to change the workspace layout in the development tools. You
can return the tools to their default layouts by selecting Window > Reset Window
Layout.
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*  Many of the menu items we use in the book have corresponding icons shown
with each menu item in the menus. Many of the icons also appear on one of the
toolbars at the top of the development environment. As you become familiar with
these icons, you can use the toolbars to help speed up your development time.
Similarly, many of the menu items have keyboard shortcuts (also shown with
each menu item in the menus) for accessing commands quickly.

You are now ready to begin your Visual C# studies with C# 2012 for Programmers,
5/e. We hope you enjoy the book!
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